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In this lab, you will continue to practice downloading, manipulating, mapping, and analyzing hydrology data that is publicly available online to continue your
study of the Buffalo-San Jacinto watershed subbasin. Specifically, you will work with elevation data from the National Elevation Dataset (NED) accessed
through The National Map Viewer and rainfall data from the National Climatic Data Center (NCDC) accessed through Climate Data Online (CDO). You will
also learn how to calculate statistics by watershed, such as mean elevation and mean annual precipitation.

Part 1: Continuing an Existing GIS Project

Opening an existing project
1. Using Windows, navigate to your HydrologyLab folder from Lab 1.
2. Double-click the HydrologyLab.aprx ArcGIS Project File.
Creating a new map
You will begin by creating a new map for Lab 2.

1. On the Standard toolbar, click the Insert tab and click New Map.
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2. At the top of the Contents pane, rename the map to "Lab2".

Projecting vector data

Before downloading any new data, you will further process data from Lab 1 in preparation for this lab.

. In the Catalog pane, expand the Databases section and the HydrologyLab.gdb geodatabase.
. Drag the Watersheds feature class into the Lab2 map view.

. In the Contents pane, double-click the Watersheds layer.

. In the ‘Layer Properties’ window, click the Source tab.

. Scroll down and expand the Spatial Reference section.
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Notice that the layer is in a geographic coordinate system called NAD 1983, which stands for North American Datum 1983. Because the data has a
geographic coordinate system, the coordinates are stored in degrees, which indicate the three-dimensional location of the data on Earth's spheroid.
Though the data itself is stored in a geographic coordinate system, your computer monitor is flat, so, even though no projection has been defined, the data
must be displayed in a particular projection. Whenever ArcGIS displays data in a geographic coordinate system, it uses a pseudo plate carrée projection,
where one degree of latitude by one degree of longitude is represented as a square, rather than a curved trapezoid. In other words, all lines of latitude and
longitude are evenly spaced. This type of projection results in stretching in the east-west direction, which increases the farther north or south from the
equator you are mapping.

1. Close the ‘LayerProperties’ window.

Working with geographic coordinate systems is fine for creating purely visual maps, as you did in Lab 1 (though the visual distortion can be disorienting
and misleading), but, in this lab, you will be calculating areas, distances, and overlaps between features. Such calculations require the three-dimensional
coordinates to be projected down onto a two-dimensional plane, so that the coordinates are stored in linear units, such as feet or meters, rather than
degrees. In order to facilitate measurements of distance and area, you will now project the Watersheds layer into the State Plane Texas South Central
projection which is best suited to mapping the greater Houston region.

. In the Analysis tab, click the Tools button to open the Geoprocessing pane.

. In the 'Find Tools' search box, type "project".

. Click the Project tool.

. For ‘Input Dataset or Feature Class’, use the drop-down menu to select the Watersheds layer.

. For ‘Output Dataset or Feature Class’, rename “Watersheds_Project” to “Watersheds_StatePlane”, since that is the name of the projection you
will be using.

. Next to the ‘Output Coordinate System’ box, click the Select Coordinate System button.

. Double-click Projected Coordinate Systems State Plane NAD 1983 (US Feet).

. Select NAD 1983 StatePlane Texas S Central FIPS 4204 (US Feet) and click OK.
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Because both the input and output coordinate systems are based on the NAD 1983 geographic coordinate system, no geographic transformation is
required.

1. Ensure your ‘Project’ window appears as shown below and click Run.

Geoprocessing > 1%
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Now that you have the correctly projected layer, you no longer need the original NAD 1983 layer.

1. In the Contents pane, right-click the original Watersheds layer and select Remove.
2. Double-click the new Watersheds_StatePlane layer.
3. Scroll down and expand the Spatial Reference section.

Notice that the layer is now in a projected coordinate system, NAD 1983 StatePlane Texas S Central FIPS 4204 (US Feet).

1. Close the ‘Layer Properties’ window.
You may have noticed that the visual appearance of the watersheds did not change in your Map Display, even though you projected them. That is because
the data frame takes on the projection of the first layer added to it. Since you first added the original unprojected Watersheds layer into the data frame,
which was in NAD 1983, the data frame still displays the data in NAD 1983 (or psuedo plate carrée). Currently, the projected Watersheds_StatePlane layer
is being projected-on-the-fly back into NAD 1983 for visual purposes.

Move the cursor around the screen and notice that the coordinates at the bottom of the map view are shown in decimal degrees. This is another clue that
the data frame is still using a geographic coordinate system; however, you would like the data frame to display data using the local Houston projection.

1. At the top of the Contents pane, double-click the Lab 2 map to open the 'Map Properties' window.



2. Click the Coordinate Systems tab.

While you could search for or navigate to the State Plane Texas South Central projection, as you did before, in this case, you know that the same
coordinate system is already used by the Watersheds_StatePlane layer. In such an instance, it is often easier to import the coordinate system from
another known layer, especially if you are not familiar with the hierarchy of the coordinate system folders

1. Scroll to the top of the 'XY Coordinate Systems Available' list.
2. Expand Layers.

Notice that all of the coordinate systems used by layers currently in the map are displayed. You can expand the coordinate systems to determine exactly
which layers are stored in which coordinate systems.

Click NAD 1983 StatePlane Texas S Central FIPS 4204 (US Feet).

lick OK.

1.
2.

Notice that the watershed boundaries are now more compact in the east-west direction, as expected, because the local projection results in less distortion
than the pseudo plate carrée projection used to represent geographic coordinate systems.

Part 2: Downloading DEM Data

Downloading data from the National Map Viewer

Now you are ready to download digital elevation model (DEM) data for the Buffalo-San Jacinto subbasin. Some local government agencies, such as the
Houston-Galveston Area Council (H-GAC) contract to have LIDAR data collected, which provides high resolution data containing both the elevation of the
bare land and the heights of features in the built environment. Though we are lucky to have this high-quality data available in this particular region, for
projects anywhere in the U.S., the best available DEM data generally comes from the National Elevation Dataset (NED) produced by the USGS. More
information regarding NED data can be found at ned.usgs.gov. You will download NED data from The National Map Download Client.

1. In aweb browser, go to https://apps.nationalmap.gov/downloader/.
First, you will constrain your downloads to your area of interest.
1. In the 'Area of Interest' section, use the 'Map Extent/Geometry' drop-down menu button to select Selectable Polygon.

2. Use the 'Select...' drop-down menu to select 8-digit HU (Subbasin).
3. At the top right of the map, in the 'Find address or place' search box, type “Houston” and press Enter.
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After zooming into Houston, you can see the blue boundaries of the individual subbasins and each subbasin is labeled with its HUC-8 number on the map.


https://apps.nationalmap.gov/downloader/

1. Near the center of the map, click within Subbasin 12040104 to select it.
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Your data search will now be constrained to the polygon for subbasin 12040104.

Next, you will select the data products you are interested in viewing and downloading.

1
2
3
4

. If necessary, within the 'Subcategories' section, check1/3 arc-second DEM.

On the left side bar, under the 'Data’ section, check the Elevation Products (3DEP) section to expand it.

Under the 'File Formats' section, select All, which will make the ArcGrid file format available (rather than only the GeoTIFF and IMG file formats)
Scroll back to the top of the left side bar and click the Search Products button.

Datasets Products Cart

Select products below and then hit "Search Products" -
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You are now provided with a listing of all the DEM tiles covering the area of subbasin 12040104. Although 12 results are listed, there are only 3 areas of
coverage provided in 4 different file formats: ArcGrid, GeoTIFF, GridFloat, and IMG. You will download only the 3 files in the ArcGrid format

1.
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In turn, click Download ZIP for USGS NED 1/3 arc-second 1 x 1 degree ArcGrid 2019 for n30w096, n30w095, and n31w096.

Format: ArcGrid
Extent: 1 x 1 degree

USGS MED 1/3 arc-second n31wl96 1 x 1 degree Footprint =
ArcErid 2019 Thumbnail

Published Date: 2019-04-22 Zoom To

Metadata Updated: 2018-05-16 Info/Metadata

Vendor Metadata

Download ZIP

. Once all files have finished downloading, navigate to the location where the three zipped folders have been downloaded. The downloads may

take a few minutes to complete.

. Select and copy all three zipped folders.

. Using Windows Explorer, navigate to your HydrologyLab folder.

. Paste all three zipped folders directly inside your HydrologyLab folder. Do NOT paste them inside the HydrologyLab.gdb geodatabase folder.
. Select all three zipped folders.

. Right-click any of the three selected folders and select 7-Zip Extract to “*\", which will create one unzipped folder for the contents of each

zipped folder. (If you are on a personal computer without 7-Zip installed, then right-click each folder in turn and select Extract All. Leave the
default location, which is the same location as the original zipped folder, and click Extract.)

. Return to ArcGIS Pro.



Since you just added new files to your folder, you will need to refresh it in order for them to appear in the Catalog pane.

1. At the bottom of the Geoprocessing pane, click the Catalog tab.

2. Double-click Folders > HydrologyLab.

3. If you do not see your newly download folders, right-click the HydrologyLab folder and select Refresh.
4. Expand all three USGS folders to preview their contents.

Each raster file with a name such as grdn30w095_13 corresponds to a 1x1 degree tile. The file name contains “grd” for grid, followed by the latitude and
longitude of the top left corner of the tile.

Adding raster data in ArcMap

1. Drag the grdn30w095_13 raster into the Lab2 map view.

You will be asked if you would like to create pyramids. Pyramids cache the raster at multiple reduced resolutions, resulting in an increased file size, but
better rendering performance in your map view. It is normally a good idea to create pyramids, but since you will be processing the corresponding rasters
into a new file in the next step, you will not create pyramids at this time.

1. In the 'Build pyramids' window, click No.
2. Repeat the previous two steps with the grdn30w096_13 and grdn31w096_13 rasters.

Notice that the 1x1 degree tiles appear as angled rectangles, because they are being displayed in the State Plane Texas South Central projection. If the
data frame were still in the NAD 1983 geographic coordinate system, the tiles would look like squares. Now you will look up the native coordinate system
of the raster files.

1. In the Contents pane, double-click the grdn31w096_13 layer to open the 'Layer Properties' window.
2. In the Source tab, expand the 'Spatial Reference' section.

Notice the Geographic Coordinate System is NAD 1983 and that no projected coordinate system is listed. Since this coordinate system is not the same as
the one currently used by the data frame, the raster layer is being projected-on-the-fly into the State Plane Texas South Central projection.

Mosaicking raster files

The edges where the three tiles meet are currently visible, because the minimum and maximum elevation is different in each raster, causing the same
value to be represented with a different shade of gray in each raster. To solve that visual problem and also simplify future processing steps, you will
mosaic the three rasters into a single raster. Before creating a mosaic, you will need to look up some information from the original rasters.

1. Scroll back to the top of the ‘Layer Properties’ window and expand the 'Raster Information’ section.

Notice that there is 1 band, meaning that each pixel only stores a single value: the height above sea level in meters. Aerial imagery has 3 bands to store
the 3 RGB values. The format is listed as GRID, which stands for an Esri Grid, which is a raster file format native to Esri software. The pixel type and depth
is 32-bit floating point, which indicates that the cells can store decimal data.

. Close the ‘Layer Properties’ window.

. At the bottom of the Catalog pane, click the Geoprocessing tab.

. At the top left of the Geoprocessing pane, click the Back button.

In the search box, type "mosaic to new raster".

Click the Mosaic to New Raster tool.

. For ‘Input Rasters’, select the three 1x1 degree raster layers.

. For ‘Output Location’, click the Browse button.

. In the bottom right corner of the 'Output Location' window, use the drop-down menu to select File Geodatabases (instead of Folders), if
necessary.
9. Select the HydrologyLab.gdb geodatabase and click OK.

10. For ‘Raster Dataset Name with Extension’, type “DEMMosaic”. No extension is necessary when storing the raster in a file geodatabase.

11. Use the ‘Pixel Type’ drop-down menu to select 32 bit float, since that was the same type stored in the original rasters.

12. For ‘Number of Bands’, type “1". (The text appears on the right side of the field.)

13. Ensure your ‘Mosaic To New Raster’ pane appears as shown below and click Run.
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The mosaic may take a couple minutes to process. When it is complete, notice there are no longer visual seams between the tiles in the mosaicked raster.
Now that you have a single mosaic, you no longer need the three originals tiles.

1. In the Contents pane, remove all three original raster layers.

Projecting raster files

Now you need to project your mosaic into the State Plane Texas South Central projection, so that you can properly calculate spatial statistics based on the
data it contains.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "project raster".

Click the Project Raster tool.

. Use the ‘Input Raster’ drop-down menu to select the DEMMosaic layer.

. For ‘Output Raster Dataset’, rename the raster from DEMMosaic_ProjectRaster to “DEMStatePlane”

. Use the ‘Output Coordinate System’ drop-down menu to select Watersheds_StatePlane, which will import the same coordinate system used by
that layer.
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You should now see the NAD_1983_StatePlane_Texas_South_Central_FIPS_4204_Feet displayed for the Output Coordinate System.

1. Use the ‘Resampling Technique’ drop-down menu to select Cubic Convolution.

For cell size, you may normally want to keep the original resolution, which was approximately 30 m, but, in this case, you will reduce the resolution to
expedite processing times during this lab. The cell size is always specified in the same units as the projection, which in this case is feet, so you will select a
cell size of 300 feet.

1. Leave ‘Output Cell Size’ blank, but-type “300” for the ‘X’ and ‘Y".
2. Ensure your Geoprocessing pane appears as shown and click Run.
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Remember that the data frame was already displaying all layers in State Plane Texas South Central, so you should not notice much of a difference
between the two layers, other than that the cell size has increased, meaning the resolution has decreased.

1. Remove the DEMMosaic layer from the Contents pane.

Clipping raster files
Now you are ready to clip the DEM mosaic to the Buffalo-San Jacinto subbasin.

. At the top left of the Geoprocessing pane, click the Back button.
. In the search box, type "clip raster".

. Click the Clip Raster tool.

. For ‘Input Raster’, select DEMStatePlane.

. For ‘Output Extent’, select Watersheds_StatePlane.

Check Use Input Features for Clipping Geometry.
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Checking that box ensures that the raster is limited to the actual shape of the watersheds, rather than a rectangle covering the same extent.

1. For ‘Output Raster Dataset’, rename the raster from “DEMStatePlane_Clip” to “DEMSubbasin”.
2. Ensure your Geoprocessing pane appears as shown below and click Run.
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3. In the Contents pane, remove the DEMStatePlane layer.
4. Turn off the Watersheds_StatePlane layer to view the DEMSubbasin layer.

The DEMSubbasin layer is now clipped to the shape of the Buffalo-San Jacinto subbasin.

Converting raster units using the raster calculator

Right now, the elevations in the DEM are in units of meters. In order to convert these units into feet, you will use the raster calculator.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "raster calculator".

Click the Raster Calculator tool.

. In the list of ‘Rasters’, double-click the DEMSubbasin layer.

. In the list of 'Tools', double-click the * symbol.

In the equation box, type “3.281", which is the conversion factor from meters to feet.
. For ‘Output raster’, rename the raster “DEMft”.

. Ensure your ‘Raster Calculator’ window appears as shown below and click Run.
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Visually, the meters and feet layers should be identical, but, if you look at the layers in the Contents pane, you will notice that the original layer goes from
elevations of -8 to 62 meters and the newly calculated layer goes from elevations of -26 to 204 feet.

1. Remove the DEMSubbasin layer from the Contents pane.

Exploring elevation using the raster calculator

Now you will determine which portions of land may be affected by a 15’ storm surge. Obviously, complex inundation models will take more variables into
account, but, in this instance, you will simply highlight all the areas of land with an elevation of 15’ or less.

. In the Raster Calculator tool, delete the previous expression "DEMSubbasin" * 3.281.
. In the list of 'Rasters’, double-click the DEMft layer.

. In the list of 'Tools', double-click the <= symbol.

In the equation box, type “15”.

. For ‘Output raster’, rename the raster from demft_raster to “Flood 15ft”.

. Ensure your Geoprocessing pane appears as shown below and clickRun.
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7. In the Contents pane, right-click the Flood15ft layer and select Symbology.
8. In the Symbology pane, right-click the 0 value and click Remove.
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9. Click the rectangle symbol to the left of the 1 value and select Blue.
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Now the cells containing an elevation of 15 feet or less are highlighted on top of the elevation raster.

1. In the Contents pane, uncheck the Watersheds_StatePlane layer and the Topographic basmap.
2. Save your project.

FOR MAP LAYOUT TO BE TURNED IN

Create an 8.5 x 11 layout showing the DEM clipped to the subbasin with areas less than or equal to 15 feet in elevation highlighted.

Symbolizing raster files
Now you will create a new map from the one you are currently using.

. On the ribbon, click the Insert tab and click the New Map button.

. In the Contents pane, rename the map “Lab2Topo”.

. Return to the Catalog pane.

Expand the HydrologyLab.gdb geodatabase.

Drag the DEMft and Watersheds_StatePlane layers into the Lab2Topo map view.

In the Contents pane, uncheck the Watersheds_Stateplane layer.

. Right-click the DEMft layer and select Symbology.

. For ‘Color scheme’, scroll down to the very bottom and select the Multipart Color Scheme or another continuous color scheme of your choice.
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Patterns within the data are now easier to see, especially at the lower elevations.

Generating contour lines

In addition to raster DEM data, it is sometimes useful to be able to represent elevation using vector contour lines. Contour lines at any regular intervals or
discrete values can be created from DEM data.

. Return to the Geoprocessing pane.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "contour".

Click the Contour (Spatial Analyst Tools) tool.

. For ‘Input raster’, select the DEMft layer.

For the ‘Output polyline features’, rename the feature class from “Contour_DEMft1” to “Contours10ft”.

. For ‘Contour interval’, type “10".
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The base contour is the lowest contour that will be shown. Since the lowest elevation is -26 ft, you will set your base contour to -20 ft.

1. For ‘Base contour’, type “-20".

Since the XY coordinates are in the units of your State Plane Texas South Central projection, which is feet, and you have also used the Raster Calculator
to convert the Z units stored within the raster cells to feet, you do not need a custom Z factor.

1. For ‘Z factor’, leave the default value of 1.
2. Ensure your Geoprocessing pane appears as shown below and clickRun.
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. Turn off the DEMft layer to better see the contours.

. Right-click the Contours10ft layer and select Symbology.

. In the Symbology pane, use the 'Primary symbology' drop-down menu to select Unique values.

. Use the ‘Field 1’ drop-down menu to select the Contour field.

. At the bottom of the ‘Color scheme’ drop-down menu, check Show All and select one of the continuous color schemes, as shown below.
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Now you can tell which contours are highest and lowest.

1. In the Contents pane, turn off and collapse the Contours10ft layer.
2. Turn back on the DEMft layer.

Generating a hillshade

Now you will create a hillshade raster, which provides a shaded relief of the terrain based on a certain sun angle. It stores a value between 0 and 255
indicating the extent to which the cell would be shaded from the sun.

. Return to the Geoprocessing pane.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "hillshade".

. Click the Hillshade (Spatial Analyst Tools) tool.

. In the Surface toolset, double-click the Hillshade tool.

. For ‘Input raster’, select the DEMft layer.

. For ‘Output raster’, rename the raster from “HillSha_DEMf1” to “Hillshade”.
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The azimuth and altitude refer to sun angles. For now, you will stick with the default values.

As previously mentioned, the Z factor is used when the horizontal units of the projection and units of the elevation measurements stored in the raster cells
are not the same. In this case, both are measured in feet, so a value of 1 is technically correct. Typically, hillshades are used to create realistic three-
dimensional representations of mountains, which can be much easier for an audience to interpret than a flat DEM or contour lines. Unfortunately, the
opposite is true in Houston, because the area is so flat. It would be difficult to see any changes in elevation using a hillshade, since few shadows would be
cast by the terrain itself. To compensate visually for the flat terrain, you will exaggerate the vertical elevations.

1. For ‘Z factor’, type “20".
2. Ensure your ‘Hillshade’ window appears as shown and click Run.
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Typically, hillshades are shown beneath transparent layers conveying other information, just to give the map a realistic appearance.

1. In the Contents pane, drag the Hillshade layer beneath the DEMft layer, but above the Topographic basemap.
2. In the Contents pane, select the DEMft layer.

3. In the ribbon, click the contextual Appearance tab.

4. In the Effects group, slide the transparency to 60%.

Now the gradual changes in elevation are apparent from the coloring and are complimented by a realistic display of the terrain created with the hillshade.

1. Turn on the Watersheds_StatePlane layer.
2. Symbolize the Watersheds_StatePlane layer with no transparency, a hollow fill, and thick black outline.

As a final touch, you will add the flowlines you downloaded in Lab 1 to your Map Display.

. Click the Catalog tab.

. In the HydrologyLab geodatabase, drag the Flowlines feature class into the Lap2Topo map view.

. In the Contents pane, drag the Flowlines layer above the DEMft layer, but beneath the Watersheds_StatePlane layer.
. Symbolize the Flowlines layer with a thin blue line.

. Save your project.
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FOR MAP LAYOUT TO BE TURNED IN

Create an 8.5 x 11 layout showing transparent elevation in graduated colors on top of a hillshade, with watershed boundaries and flowlines visible.



Calculating zonal statistics

Now you will calculate elevation statistics by watershed.
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. Return to the Geoprocessing pane.
. At the top left of the Geoprocessing pane, click the Back button.
. In the search box, type "zonal statistics".

Click the Zonal Statistics as Table (Spatial Analyst Tools) tool.
Use the ‘Input raster or feature zone data’ drop-down menu to select the Watersheds_StatePlane layer.
For ‘Zone field’, select the ‘HU_10_NAME’ field.

. For ‘Input value raster, select the DEMft layer.
. For ‘Output table’, rename the table from “ZonalSt_Watersh1” to “WatershedElevation”.
. Ensure your Geoprocessing pane appears as shown and click Run.




Geoprocessing 1%
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© Zonal Statistics as Table ®

Parameters Environments

Input raster or feature zone data

Watersheds_StatePlane - il
Zone field
HU_10_MAME -

Input value raster
DEMFt -

Output table

WatershedElevation

Ignore MoData in calculations
Statistics type
All M

|:| Process as multidimensional

10. At the bottom of the Contents pane, right-click the WatershedElevation table and select Open.

This table tells you the statistics regarding all the elevation values within each watershed zone.

. In the Geoprocessing pane, search for "table to excel’.

. Click the Table To Excel tool.

. For 'Input Table', select WatershedElevation.

For ‘Output Excel File’, click the Browse button.

Locate and double-click the HydrologyLab folder to save the file within the folder.
For ‘Name’, type “WatershedElevation”.

. Click Save.

. In the Geoprocessing pane, click Run.

. Close the WatershedElevation table.
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Now you will open the exported text file in Excel.

1. Using File Explorer, open your WatershedElevation.xIs spreadsheet in Microsoft Excel.
2. Delete the OBJECTID, ZONE_CODE, COUNT, AREA, and SUM fields.
3. Highlight the minimum and maximum values in each column.

Continue formatting the table until you are satisfied with its appearance.

. Click the File menu and select Save As.

. Navigate to your HydrologyLab folder.

. For ‘File name:’, type “WatershedElevation”.

. Use the ‘Save as type:’ drop-down menu to select Excel Workbook (*.xIsx).
Click Save and close Excel.
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FOR TABLE TO BE TURNED IN

Create a table highlighting the minimum and maximum values for the minimum, maximum, range, mean, and standard deviation of all elevation values
within each watershed.

HUC-10 WATERSHED NAME MIN MAX RANGE MEAN STD
Addicks Reservoir] 52.26874161| 176.1098328| 123.8410912| 132.1526735| 22.41935789
Barker Reservoir]  79.0615921| 204 5362081 125.474617| 136.7137891| 29 46773305
Brays Bayou| -0.847274601| 125.3090897| 126.1563643| 65.58334423| 19.35789672
Buffalo Bayou-San Jacinto River] -6.422118157| 182.0424652| 188.4645834| 34.06303519| 16.06072267
East Fork Goose Creek-Frontal Galveston Bay| -8.17120266| 57.56740952| 65.73861217| 16.65401267| 11.09514906
Greens Bayou| -26.46365929| 193.2014771| 219.6651363| 71.5731662| 26.54297872
Sims Bayou| -2.798070669| 119.7956233| 122.5936944| 45.96954918] 14.10813035
Whiteoak Bayou-Buffalo Bayou| -3.632341385| 153.6858063) 157.3161477| 82.19689409| 22.36053682




Part 3: Downloading rainfall data

Downloading data from Climate Data Online.
Now you will download rain gauge station data created by the National Climatic Data Center (NCDC) using the Climate Data Online (CDO) interface.

1. In a web browser, go to www.ncdc.noaa.gov/cdo-web/.
2. Click the Mapping Tool tab.

TIONAL CENTERS FOR 7N
VIRONMENTAL INFORMATION &,

You will search for data using the NHD hydrologic units. Previously, you had been working with the Buffalo-San Jacinto subbasin (HUC = 12040104). In
this case, you will step up two levels to the Galveston Bay-San Jacinto subregion (HUC = 1204).

1. On the Surface Maps tab, click Normals.
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2. In the left sidebar, on the Layers tab, uncheck Daily Climate Normals, and check Annual Climate Normals.
3. To the right of Annual Climate Normals, click the Map Tools button.

Annual Climate Normals

In the new ‘ANNUAL CLIMATE NORMALS TOOLS’ window, click Location.
Use the drop-down menu to select USGS HUC.

Use the ‘Select a HUC type’ drop-down menu to select Subregions (4-digit).
Use the ‘Select a HUC’ drop-down menu to select Galveston Bay-San Jacinto.
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http://www.ncdc.noaa.gov/cdo-web/
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8. Click Zoom to location.
9. The left sidebar switches to the Results tab. Click Get All Location Data.

1 Layers i Results b

[] selectau Download Station List 2

GALVESTON BAY-S5AMN JACINTO
Location ID: HUC:1204

‘W Get All Location Data

[] rRICHARDS, TX US

«» View Station Details

Station ID: |
Period of Record:

10. For Step 1, select Custom Annual/Seasonal Normals CSV for the output format and click CONTINUE.

Custom Annual/Seasonal Normals CSV
(Additional options available on next page)

11. For ‘Station Detail & Data Flag Options’, check Station Name, Geographic Location, and Include Data Flags to include those variables the
data table.

Station Name
Geographic Location
Include Data Flags

12. For ‘Select data types for custom output’, expand the Annual Precipitation category.
13. Check Long-term averages of annual precipitation totals (ANN-PRCP-NORMAL).



Show All / Hide All | Select All / Deselect All

[J ®Annual Agricultural

0 ®Annual Degree Days

€’Annual Precipitation

Long-term averages of annual precipitation totals (ANN-PRCP-
NCRMAT)
14. At the bottom of the window, click CONTINUE.
15. Type your email address twice and click SUBMIT ORDER.

Check your email. You should receive two emails a couple minutes apart, although it may take a few hours to receive the second email. The first one
indicates that your data request was submitted and the second one includes the requested data.

1. In your email, click the Download link to download the requested CSV file.

& NOAA ERVRONERAT N GRirarion

ATMOSPHERIC ADMINIS

Order Complete

Your order has been processed and is ready for download. Use the links below to download
the individual orders.

If any part of your order has certifiable data, a link will be supplied that will help you with the
certification process.

Documentation for each dataset is linked from within the order for your convenience.

Order Details

Order #850264 (Custom Annual/Seasonal Normals CSV)

File Download h

OrderID 850264
Date Submitted 2016-11-3004:30
Order Summary View Summary

Documentation View Documentation

Excel

1. Navigate to the location where the CSV file was stored.
2. Double-click the CSV file to open it using Excel.

The first column contains the unique station identification code and the second column contains the station name. Next are the latitude, longitude, and
elevation of the stations. The annual precipitation field contains long-term averages of annual precipitation totals in hundredths of inches. More information
is available on the Datasets portion of the CDO website.

(D As of March 7, 2021, the CSV download includes ALL climate variables, even though only ANN-PRCP-NORMAL was selected for download. In
this case, the annual precipitation field, ANN-PRCP-NORMAL, will not appear in column F, after the ELEVATION field. Instead, it appears in
column BP. In this case, you will need to copy and paste the data from column BP to column F.

Before opening this table in ArcGIS, you must reformat some of the field names, which cannot have special characters and are recommended to be 13
characters or less.



. Rename “ANN-PRCP-NORMAL" to “ANNPRCP_HI", for annual precipitation in hundredths of inches.
. Along the top of the worksheet, drag across the column letters to select columns A through F.

Copy the selected columns.

. At the bottom left of the worksheet, click the New sheet button ) to create a new worksheet. In cell Al, paste your previously copied columns.
. Delete the previous sheet.

. Along the top of the worksheet, drag across the column letters to select columns A through F.

. Hover your mouse between columns E and F until the cursor changes to two outward facing arrows and double-click to auto-size the column

widths.

. At the bottom left of the worksheet, rename the worksheet from Sheetl to “PrecipStations”.
. Click the File menu and select Save As.

. Navigate to your HydrologyLab folder.

. For ‘File name?’, type "PrecipStations".

. Use the ‘Save as type:’ drop-down menu to select Excel Workbook.

. Click Save.

. Close Excel.

Displaying XY data

Now you are ready to start a new map and display the tabular rain gage data you just downloaded.

10.
11.
12.
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. Return to ArcGIS Pro.

. On the ribbon, click the Insert tab and click the New Map button.
. In the Contents pane, rename the map “Lab2Precip”.

. Return to the Catalog pane.

Drag Watersheds_StatePlane into the Lab2Precip map view.

. Right-click the HydrologyLab folder and select Refresh.

Expand the PrecipStations.xIsx Excel file to see the individual worksheets it contains.
Drag the PrecipStations$ worksheet into the Lab2Precip map view.

In the Contents pane, right-click the PrecipStations$ table and select Display XY Data.
For ‘X Field:’, select the LONGITUDE field.

For ‘Y Field:’, select the LATITUDE field.

For 'Coordinate System’, click the Select coordinate system button.

Because the coordinates are in the form of latitude and longitude in decimal degrees, you know you will need to select a geographic coordinate system,
rather than a projected coordinate system. While the data could theoretically be in any geographic coordinate system, you will select the North American
Datum 1983, commonly abbreviated NAD 83, because this is coordinate system of the data provided on the NCDC website.

1.
2.
3.

Scroll towards the top of the 'XY Coordinate Systems Available'.
Ensure that Geographic Coordinate Systems is already expanded, then expand North America > USA and Territories.
Select NAD 1983 and click OK.



4. Ensure that your window matches that below and click OK.

Display XY Data ? X
Parameters Environments
Input Table
PrecipStations$ v

Output Feature Class
PrecipStations_XYTableToPoint

X Field

LOMGITUDE v
Y Field

LATITUDE -
Z Field

Coordinate System

GC5_Morth_American_1983 - @

The points should now appear on top of the watersheds, though they also extend beyond the watersheds in the Buffalo-San Jacinto subbasin, since we
downloaded them for the entire Galveston Bay-San Jacinto subregion.

1. In the Contents pane, right-click the PrecipStations$ table and select Remove.

Projecting vector data

Repeating the technique you learned earlier in this lab to project vector data, project the PrecipStations_XYTableToPoint layer into the State Plane Texas
South Central projection. Save the resulting feature class and name it “PrecipStations_StatePlane”. Remove the original PrecipStations_XYTableToPoint
layer from the Contents pane.

Create Thiessen polygons

Now you will calculate the mean annual precipitation over each watershed using Thiessen polygons, which associate every cell in the watershed with the
nearest rain gage.

In the Contents pane, Ctrl-select the PrecipStations_StatePlane and Watersheds_StatePlane layers.
. Right-click either selected layer and selectZoom To Layers.

. Return to the Geoprocessing pane.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "thiessen".

. Click the Create Thiessen Polygons tool.
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Before populating the variables in this tool, you will change an Environment setting so that the Thiessen polygons are calculated for the entire region that
you just zoomed to.

1. At the top of the Geoprocessing window, click the Environments tab on the right.
2. Under the 'Processing Extent' section, for 'Extent’, select Current Display Extent.
3. At the top of the Geoprocessing window, return to the Parameters tab on the left.




For ‘Input Features’, select the PrecipStations_StatePlane layer.

For ‘Output Feature Class’, rename the feature class from “PrecipStations_StatePlane_Cr” to “PrecipThiessen”.
For ‘Output Fields’, select All fields.

Ensure your ‘Create Thiessen Polygons’ window appears as shown below and click Run.

No oM

Geoprocessing - B X

P

€ Create Thiessen Polygons 'b'

Parameters Environments f

(==

Input Features

PrecipStations_StatePlane - il
Output Feature Class

PrecipThiessen

Qutput Fields
All fields d

You will notice that polygons now fill the entire Map Display indicating which areas are closest to which rain gages.
1. Open the PrecipThiessen layer attribute table.

Notice that all of the fields that you originally downloaded from CDO are still included, because you selected to output all fields when running the Create
Thiessen Polygons tool. If you do not see all of the same fields, re-run the tool and this time output all fields.

1. Close the PrecipThiessen attribute table.

Intersecting two polygon layers

In order to determine which portions of the resulting polygons overlap with which watersheds, you will now perform an intersect operation between the two
layers. The result will allow you to calculate weighted averages of the precipitation in each watershed.

. At the top left of the Geoprocessing pane, click the Back button.

. In the search box, type "intersect".

. Click the Intersect tool.

. For ‘Input Features’, select the PrecipThiessen and the Watersheds_StatePlane layers.

. For ‘Output Feature Class’, rename it from PrecipThiessen_Intersect to “ThiessenWatershedIntersect”.
. Ensure your ‘Intersect’ window appears as shown below and click Run.
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-
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Attnbutes To Join
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7. In the Contents pane, remove the PrecipThiessen layer.
8. Zoom to the ThiessenWatershedIntersect layer.

The resulting layer integrates all of the boundaries from both the Thiessen polygons and the watersheds, limited to the extent of their overlap.
1. Open the ThiessenWatershedIntersect layer attribute table.

Notice that the original 8 watersheds have now been divided into 41 sections indicating which areas of each watershed are closest to each rain
gage. Let P, denote the annual precipitation associated with each rain gage and A; denote the area of the intersected polygon associated with

rain gage , and watershed ;. The area weighted precipitation associated with each watershed is

p = Lk AirPr
i — Z _
k “lik

You will add a new field to the table to calculate the elements of the numerator of the equation.

2. At the top left of the attribute table, click the Add Field... button, which will open up the Fields view of the table.

Fleld: 2 B8  Selection: ?E"' =

4 OBJECTID Shape FID_PrecipThiessen Input_FID STATION
I 1 Polygon 4 31 USC004118 -
2 Polygon = 31 USC004118
3 Polygon 4 31 USC004118

3. At the bottom of the Fields table, rename the new field from Field to “APProd”.
4. Use the ‘Data Type’ drop-down menu to select Double.
5. On the Ribbon, on the Fields tab, click the Save button.

- - 3 Feature Laye

Fields Insert Analysis View Share Appearance Label
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Clipboard Design Filter Changes




6. Close the Fields view of the table.
7. Scroll to the far right of the ThiessenWatershedIntersect table.
8. Right-click the APProd field name and select Calculate Field.
9. In the 'Fields' list, double-click ANNPRCP_HI.
10. Underneath the 'Helpers' list, click the * button.
11. In the 'Fields' list, double-click Shape_Area.
12. Ensure your ‘Calculate Field’ window appears as shown below and click OK.

Calculate Field ? X

Input Table
ThiessenWatershedlntersact -

Field Mame (Existing or New)
APProd -

Expression Type
Python 3 -

Expression

Fields T Helpers T
— - | — .
LONGITUDE as_integer_ratic()

ELEVATION .«capitalize()

AMNMPRCP_HI .center()
FID_Watersheds_StatePlane -conjugate()

HU_10_MNAME .count()

Shape_Length decode()

.denominaton()

Shape_Area - -
Insert Values | o+ - =
APPred =
IANNPRCP_HI! * !Shape_Area!
L 4
Enable Undo Lpply oK

The APProd field now contains the numerator values in the equation. You are now ready to summarize the calculated statistics by watershed.

Right-click the HU_10_NAME field name and select Summarize.

For ‘Output Table’, rename the table from ThiessenWatershedinteract_S to “WatershedPrecip”.

For 'Statistics Field(s)', use the drop-down menu to select the Shape_Area 'Field' and the Sum 'Statistic Type'.
For the second statistics field, select the APProd 'Field' and the Sum 'Statistic Type'.

Ensure the 'Case field' is the HU_10_NAME field, which will summarize the statistics by watershed.

Ensure your 'Summary Statistics" window appears as shown below and click OK.
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Summary Statistics ?7 X

Input Table
ThiessenWatershedIntersect -

Output Table
WatershedPrecip

Statistics Field(s)
Fizld ::_-—:: Statistic Type
Shape_Area | | Sum -

APProd | | Sum -

. )
Case field ()

HU_T0_MAME -

The resulting table gives the numerator and denominator in the equation for each watershed.

1.

Open the WatershedPrecip table.

Repeating the techniques you just learned, add a new field to the WatershedPrecip table called “Precip” of type double. Use the field calculator to evaluate
[Sum_APProd]/[Sum_Shape_Area]. The result is the precipitation for each subwatershed. Export the table to Excel and format it. Also include the mean
annual precipitation over the entire watershed.

FOR TABLE TO BE TURNED IN

Create a table containing the weighted mean annual precipitation for each watershed, as calculated using Thiessen polygons, along with the total mean
annual precipitation over the entire subbasin.

Interpolating point values

Now you will calculate precipitation for each watershed using a different interpolation method.

OCONOTRWONER

. Close the WatershedPrecip table and the ThiessenWatershedIntersect attribute table.
. Turn off the ThiessenWatershedIntersect layer.

. Right-click the Watersheds_StatePlane layer and select Zoom to Layer.

. At the top left of the Geoprocessing pane, click the Back button.

In the search box, type "spline".

. Click the Spline (Spatial Analyst Tools) tool.

. At the top of the Geoprocessing window, click the Environments tab on the right.

. Under the 'Processing Extent' section, for 'Extent’, select Current Display Extent.

. Under the 'Raster Analysis' section, for ‘Mask’, select the Watersheds_StatePlane layer, which will clip the resulting raster.
. At the top of the Geoprocessing window, return to the Parameters tab on the left.

. For ‘Input point features’, select the PrecipStations_StatePlane layer.

. For ‘Z value field’, select the ANNPRCP_HI field that contains the values you wish to interpolate.

. For ‘Output raster’, rename the exported raster from Spline_Precil to “AnnPrecip”.

. For ‘Spline type’, select Tension.

Ensure your Geoprocessing pane appears as shown below, and click Run.
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The result is a solid surface estimating the rainfall at each cell, based on the data collected at each rain gage. Turn the ThiessenWatershedIntersect
polygons back on and give them a hollow fill. Also symbolize the Watersheds_StatePlane layer and put it on top of the Thiessen layer. Symbolize the rain
gages as you desire.

FOR MAP LAYOUT TO BE TURNED IN

Create an 8.5 x 11 layout showing the Thiessen polygon boundaries, interpolated rainfall layer and rain gage locations.

9

Using the techniques you learned earlier in this lab, use the Zonal Statistics as Table tool to export a table containing the total annual rainfall for each
watershed, as calculated from the AnnPrecip spline interpolation layer and format the table in Excel.



FOR TABLE TO BE TURNED IN

Create a table containing the total annual precipitation for each watershed, as calculated using the spline interpolation method, along with the total annual
precipitation over the entire subbasin.

Deliverables

. Create an 8.5 x 11 layout showing the DEM clipped to the subbasin with areas less than or equal to 15 feet in elevation highlighted.

. Create an 8.5 x 11 layout showing transparent elevation in graduated colors on top of a hillshade, with watershed boundaries and flowlines visible.

. Create a table highlighting the minimum and maximum values for the minimum, maximum, range, mean, and standard deviation of all elevation
values within each watershed.

4. Create a table containing the weighted mean annual precipitation for each watershed, as calculated using Thiessen polygons, along with the total

mean annual precipitation over the entire subbasin.

5. Create an 8.5 x 11 layout showing the Thiessen polygon boundaries, interpolated rainfall layer, and rain gage locations.

6. Create a table containing the total annual precipitation for each watershed, as calculated using the spline interpolation method, along with the

total annual precipitation over the entire subbasin.
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